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Trademarks 
 
This manual makes reference to the following products. These products are registered 
trademarks of their manufacturers: 

 ®AutoCAD is a registered trademark of Autodesk, Inc. 
 ®Windows is a registered trademark of Microsoft Corporation 
 ®Pentium is a registered trademark of Intel Corporation 
 ©Plans & Elevations 2011 by PROCAD Software  
 ©Isometrics 2011 by PROCAD Software  
 ©Electrics 2011 by PROCAD Software  
 ©P&ID 2011 by PROCAD Software  
 ® FlexNet, LMtools are registered trademarks of Flexera Software  
 ™ PapriCAD is a trademark of PROCAD Software  

 
Other products mentioned are trademarks of their respective companies. 
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License Management 

Introduction 
Licenses may be purchased from PROCAD Software as standalone or network.  Standalone 
licenses, once activated, are only accessible by one machine.  Networked, licenses exist in a 
pool, and may be accessed across a company’s network from any computer.  The maximum 
number of users that may work at the same time will be equal to the number of concurrent 
licenses in the pool. 

The installation of the software, along with the type of license purchased, will define the 
manner in which licenses will be managed, and the procedures that are allowed. 

For more information about installation, please refer to the Installation Guide. 

Configuration Options 
There are many configuration options available for installation.  Below is a chart with some 
of the most common configurations: 

 
 Configuration 

1 
Configuration 

2 
Configuration 

3 
Configuration 

4 
Applications 

Data Files 

Licensing 
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Legend 
 

 

Workstation 
installation 

 

Network server #2 
installation 

 

Network server #1 
installation 

  

 

Configuration 1 
This configuration represents a truly standalone installation.  The user has a standalone 
license and will not be sharing data with any other users.   

This configuration should be used when the software is being evaluated and for a single-user 
environment. 

Configuration 2 
This configuration represents the situation where there are multiple users that need to share 
data, but have standalone licenses.  In this scenario, the data files must first be installed onto 
a network location before the individual workstations have the applications and licenses 
installed. 

This configuration is most often used for small companies that have chosen standalone 
licenses but must still share data. 

Configuration 3 
This configuration represents the situation where it is desired to have the data and the 
licenses on the same network server, and only the applications reside on the workstations.  In 
this example, the data files and licenses need to be installed on the server before the 
applications are installed on the individual workstations. 

This configuration is most often used for small or medium companies that purchase network 
licenses, and prefer to keep all of the PapriCAD files on one server, or when only one 
network server is available. 
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Configuration 4 
This configuration represents the situation where it is desired to have the data and the 
licenses installed on separate servers. In this configuration, the data files and licenses need to 
be installed on the servers before the applications are installed on the individual 
workstations. 

This configuration is most often used for small through large companies that have network 
licenses, and have multiple servers available for selection.  Commonly, one server has 
already been designated for licenses for other applications and a second server already 
contains data for the drafting department. 

The four configurations above are the most common installation options encountered.  
However, it is possible to install the applications onto a network server as well, introducing a 
number of new configuration possibilities. 

For all installation configurations, it is important to do the server portions of the installations 
before the workstations installation are started. 

License Application Options 
There are two License Applications that may be installed, based on the configuration chosen 
during the installation.   

 
 PROCAD’s License Manager Flexera’s FlexNet 

LMTools 
Configuration Installed for standalone 

configurations and license servers. 
Installed for license servers 
only. 

Application 

 
Procedures   Request license codes 

 Apply license codes 
 View license status 
 View floating license usage 

 View list of computers 
acting as clients or servers 

 Specify which machines or 
workgroups may access 
the licenses. 

Manuals  License Management User Guide  FlexNet Licensing End 
User Guide 
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Procedures 

PROCAD’s License Manager 

Introduction 
The License Manager allows you to work with your PROCAD application licenses. Using 
the License Manger you can: 

 View license status for each module or application 
 Purchase additional licenses 
 Request license codes 
 Apply license codes 
 View the floating license usage 

 
 Warning: Never move the license folder to a new location. Moving this folder 

invalidates all current licenses. If for some reason you must place the license folder 
in an alternate location, contact PROCAD technical support for assistance. 

 

PROCAD’s License Manager Procedures 

Opening the License Manager 

To open the License Manager... 
Click on the License Manager icon in the PapriCAD folder.  
 

 
 
The License Manager dialog box appears. 
 



PapriCAD License Manager User Guide 
Procedures 

Page 9 

 

 

Viewing License Status 
You can view current license information for specific applications using the License 
Manager dialog box. 

To view license information... 

In the Applications field, click the module or application for which you want to view license 
data. If the module or application has active licensing, these fields display data: 

 License name and location: This directory is selected when you perform 
the initial installation.  

 Version 
 Licenses (number of) 
 Duration 

 

Purchasing Licenses 
You can purchase additional software licenses from PROCAD Software at any time. 

To purchase licenses… 

Contact sales at: 
  sales@procad.com  
  phone +1 (403) 216-3375 
 fax +1 (403) 216-3378 
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Requesting License File 
If the computer you are installing from has access to the Internet: 

1. Open the License Manager dialog box using the shortcut in the PapriCAD folder. 

2. Press the License Online button in the License Manager.  It may take a few moments 
for the web page to appear. 

3. Complete the required information on the web form. 

4. Click the Submit button at the bottom of the web page.  The licenses will be 
returned to you via e-mail. 

If the computer you are installing from does not have access to the Internet: 

1. Open the License Manager dialog box using the shortcut in the PapriCAD folder. 

2. Copy the HostID and computer name information into a text file. 

3. If the computer you are installing from is located on a network, save the text file on 
the network so that it may be accessed from another machine with an Internet 
connection.  This file may then be e-mailed to support@procad.com. 

Otherwise, print the text file and fax to +1 (403) 216-3378. 

Applying License File  

1. When you receive your license file by email, open the License Manager dialog box. 

2. Save the file to the location listed in the license path at the top of the dialog box. 

Viewing Floating Licenses 
You can view this floating license information in the Floating Licenses dialog box: 

 List of licenses currently in use 
 Name of the computer where the license currently operates 
 Login name of the user  

 
This feature is only available for networked licenses. 

To view floating license information... 

1. In the Application list of the License Manager Dialog box, click an application. If 
there are current licenses for this application, the Licenses, Duration, and Version 
fields populate.   
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2. Click the Floating Licenses button to open a dialog box where you can view 
floating license information. 

Viewing the License File 
The license file contains the information about all licenses that have been issued by 
PROCAD Software.  More information about the contents of the license file is found in the 
section titled License Files.  

To view the license file... 

• Click the View menu and select the License File command. 

OR 

• Browse using Windows Explorer to the folder that contains the file 
PROCADLicense.lic.  Open this file using Notepad.  It is important that the 
file not be modified.  The default location of this file is c:\Program 
Data\PROCAD\Licenses\FlexNet\ 

 

 

Moving Between License Types 
If you decide to upgrade a standalone license to a network license, you will need to direct the 
workstation to look to the license server for the license file instead of at its own file location.  

To move between license types... 

1. From the Edit menu, select the Change License Type command.  The License Type 
dialog will open. 

 

2. Select the desired license option. 

DO NOT MODIFY THE LICENSE FILE. 
Doing so may invalidate the licenses, requiring assistance from PROCAD 
Software.  For companies without a maintenance contract, this will incur a 
service charge. 
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3. If you select the Standalone option, you will be prompted to browse to the location 
of the local license file.  By default, this is 
c:\ProgramData\PROCAD\Licenses\FlexNet\ 

 

4. If you select Workstation, you will be prompted to enter the name of the server 
where the network license file is located.  This is always in the format of 
@SERVERNAME 

 

Windows Firewall Exception 
When a license server is setup on a computer that utilizes Windows Firewall you 
need to add the PROCAD.exe vendor daemon and lmgrd.exe to the exceptions list. 
 

To add the exception on Windows 7... 

1. Open the Control Panel 
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2. Select System and Security 
3. Under Windows Firewall select Allow A program though windows Firewall 

 
4. Click the Change settings button 

 
5. Click the Allow another program… button 

 
6. Click on the Browse… button 

 
7. Navigate to the license folder and select PROCAD 

 
8. Click the Open button 

 
9. Click the Add button 

 
10. Repeat steps 5-9 while selecting lmgrd instead of PROCAD 

 
11. Click the OK button 

To add the exception on Windows Vista... 

1. Open the Control Panel 

2. Under Security select Allow a program though Windows Firewall 

3. Click the Add program… button 

4. Click the Browse… button 

5. Navigate to the license folder and select PROCAD 

6. Click the Open button 

7. Click the Ok button 

8. Repeat steps 3-7 while selecting lmgrd instead of PROCAD 

9. Click the Ok button 
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FlexNet Configuration Tools 

FlexNet Configuration Tools 
The License Manager uses FlexNet® license management technology from Flexera 
Software.  FlexNet provides administrative tools that help to perform additional management 
actions for network licenses.  You can use FlexNet tools to monitor network license status, 
reset licenses lost to a system failure, troubleshoot license servers, and update existing 
license files on the fly. 

The PROCAD License Manager is used to request new or additional licenses, view the 
licenses in use, and to view the information about the licenses and the computer. 

Utilities for License Server Management 
FlexNet provides two utilities for managing the license server.  These tools are located in the 
default license folder on the server, which is c:\ProgramData\PROCAD\Licenses\FlexNet\. 

Lmtools.exe – Provides a Windows user interface for managing the license server.  A 
shortcut for this application is provided in the PapriCAD folder on the desktop. 

Lmutil.exe – Provides a set of command line options for managing the license server. 

You can use either of these applications to perform the following server management tasks: 

 Start, stop, and restart the license service 
 Configure, update, and reread the license file 
 Diagnose system or license problems 
 View server status, including active license status. 

Learning About Your License 
In this section, more information about the licenses, such as license operation and 
availability, the license file, license types and behaviors, and the heartbeat signal will be 
described. 
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License Operation and Availability 
When you start a PROCAD application, the product determines through the registry the 
server from which is should try to obtain a license.  The product then requests a license 
through the TCP/IP network protocol to the license server. 

If the number of available licenses has not been exceeded on the license server, the server’s 
License Manager assigns a license to the workstation.  The application completes its startup 
process on the workstation, and the number of available licenses on the server is reduced by 
one. 

Likewise, when you exit a PROCAD application, the server’s License Manager increases the 
number of available licenses by one, freeing up an additional license for another user.  Every 
application that is opened on an individual workstation reduces the number of available 
licenses.  For example, opening three P&ID applications on one workstation using 
networked licenses reduces the number of available licenses on the server by three. 

For standalone licenses, or licenses that exist on the workstation itself, multiple applications 
may be opened with the license.  For example, opening three P&ID applications on one 
workstation using standalone licenses only requires one standalone license. 

The following three processes manage the distribution and availability of licenses: 

• License manager daemon (lmgrd.exe).  Handles the original contact with the 
application and then passes the connection to the vendor daemon.  The lmgrd.exe 
daemon is used to communicate with the vendor daemon only; lmgrd.exe does not 
authenticate or dispense licenses, but rather passes user requests to the vendor 
daemon.  By using this approach, a single lmgrd.exe daemon can be used by 
multiple software vendors to provide license authentication.  The lmgrd.exe daemon 
starts and restarts the vendor daemons as needed. 

• PROCAD vendor daemon (Procad.exe).  Tracks the licenses that are checked out 
and workstations that are using them.  Each software vendor has a unique vendor 
daemon to management vendor-specific licensing.  As its name implies, the 
procad.exe is specific to PROCAD products. 

 

 

 

 

• License file.  A text file that has vendor-specific license information. 

License Files 
The network license file you receive from PROCAD contains licensing information required 
for your network or standalone installation.  You obtain license file data when you apply for 
licenses using the requesting License procedure. 

NOTE:  If the Procad.exe vendor daemon terminates for any reason, all users 
lose their licenses until lmgrd.exe restarts the vendor daemon or the problem 

causing the termination is resolved 
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The license file contains information about network server nodes and vendor daemons.  It 
also contains an encrypted digital signature that is created when PROCAD generates the file. 

The license file is located in a network location that is specified during installation.  By 
default, this location is at c:\ProgramData\PROCAD\Licenses\FlexNet\ on the license server.   

The following table defines the various license file parameters. 

Definitions of License File Parameters 

Line Parameters Definition Example 

SERVER Host Name Host name of the server where 
the network License Manager 
resides 

DRAFTSVR 

 Host ID Ethernet address of the server 
where the network License 
Manager resides 

001C234C9AEA 

VENDOR Vendor Daemon Name of the server-side 
PROCAD vendor daemon 

procad.exe 

 Port Number Network port number which 
may be reserved and assigned 
for use only by PROCAD 
products running the PROCAD 
vendor daemon 

port=2080 

PACKAGE Version Internal version number 
reference 

1.000 

 SUPERCEDE Replacement for any existing 
Increment line of the same 
feature code from any license 
files on the same license server 
that have a date earlier than the 
defined Issue Date 

SUPERCEDE 

 SIGN Encrypted signature used to 
authenticate the attributes of the 
license file 

SIGN=0 SIGN2=0 

INCREMENT Feature Code Product supported by the license 
file 

P&ID 

 Expiration Date Amount of time the licenses are 
available 

permanent 

19-mar-2010 

 Number of Licenses Number of licenses supported 
by the license file 

25 

 VENDOR_STRING License usage type and license PROCAD 
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behavior of the product that is 
supported by the license file 

 ISSUED Date that the license file was 
generated by PROCAD 

16-feb-2009 

 SIGN Encrypted signature used to 
authenticate the attributes of the 
license file 

SIGN=6E88EFA8D

Heartbeat Signal 
When a PROCAD product is running, it communicates with the license server at regular 
intervals using a communication method known as the “heartbeat” signal.  If the heartbeat 
signal is lost, the server tries to reconnect.  If the server cannot reconnect, the user receives a 
license error. 

If the product stops working because it has lost a connection to the server, you must shut 
down the product, and then restart it.  If the problem causing the original loss of the 
heartbeat signal is resolved and there are available licenses on the server, the program can be 
restarted. 

License File Examples 
License file examples are provided in this User Manual to help you understand how the 
licenses files work for your particular network setup.  PROCAD provides a standard license 
file for individual products. 

Standalone Permanent License 
VENDOR PROCAD 

INCREMENT ELECTRICS1 PROCAD 1.0 permanent uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
INCREMENT PID1 PROCAD 1.0 permanent uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
INCREMENT ISOMETRICS1 PROCAD 1.0 permanent uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
INCREMENT PLANS1 PROCAD 1.0 permanent uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
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 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
 

Standalone Temporary License 
VENDOR PROCAD 
 
INCREMENT ELECTRICS1 PROCAD 1.0 19-mar-2010 uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
INCREMENT PID1 PROCAD 1.0 19-mar-2010 uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
INCREMENT ISOMETRICS1 PROCAD 1.0 19-mar-2010 uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
INCREMENT PLANS1 PROCAD 1.0 19-mar-2010 uncounted \ 
 HOSTID=123123123123 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123"  
 

Network Permanent License 
SERVER Licensesvr 123123123123 

VENDOR PROCAD 

INCREMENT ELECTRICS1 PROCAD 1.0 permanent 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
INCREMENT PID1 PROCAD 1.0 permanent 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
INCREMENT ISOMETRICS1 PROCAD 1.0 permanent 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
INCREMENT PLANS1 PROCAD 1.0 permanent 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
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Network Temporary License 
SERVER Licensesvr 123123123123 

VENDOR PROCAD 

INCREMENT ELECTRICS1 PROCAD 1.0 19-mar-2010 1 \ 
 ISSUED=17-Feb-2010 SIGN="0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123" 
INCREMENT PID1 PROCAD 1.0 19-mar-2010 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
INCREMENT ISOMETRICS1 PROCAD 1.0 19-mar-2010 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
INCREMENT PLANS1 PROCAD 1.0 19-mar-2010 1 ISSUED=17-Feb-2010 \ 
 SIGN="0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123 \ 
 0123 0123 0123 0123 0123 0123 0123 0123 0123 0123" 
 

Borrowing Licenses 
The borrow feature will allow a license to be checked out from the network server to a local 
machine for a period of time, determined by the user.  This is useful when the computer 
where the application is to be run will not be connected to the network for a period of time, 
such as when a laptop must be brought out of the office to a field office.  The borrow feature 
is not automatically added to all network licenses, and must be requested from PROCAD.   

To request the borrow feature, please contact sales at: 

  sales@procad.com  
  phone +1 (403) 216-3375 
 fax +1 (403) 216-3378 
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Dialog Boxes 

License Manager Dialog Box 
Use this dialog to:  

 View license status 
 Request additional licenses 
 Access the Floating Licenses dialog box 

To access this dialog box...  
Open the License Manager Dialog box using the shortcut in the PapriCAD folder. 
 

 
 
In this field… Do this… 

Applications List Click the application for which you want to view or change 
license information. 

License Field and 
Button 

Nothing. This field displays current license location. You 
can relocate the license using the Select Folder button to the 
right of the field. 

Version Nothing. This field displays user level for the license for the 
application selected in the Applications list. 

Licenses Nothing. Displays the number for licenses for the 
application selected in the Applications list. 
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In this field… Do this… 

Duration Nothing. This field displays the remaining license period for 
the selected application. 

Host ID Ethernet address of the computer running the visible 
instance of the License Manager. 

Computer Host name of the computer running the visible instance of 
the License Manager.  

OK Click to close this dialog box 

Floating Licenses Click to access the Floating Licenses dialog box where you 
can view floating license information for the application you 
select in the Applications List. 

License Online Click to license the product through the website. This will 
take you to http://www.procad.com/license.php 

Help Click to access Help for this dialog box. 

Floating Licenses Dialog Box 
Use this dialog box to view a list of all licenses for the selected application. This dialog box 
displays: 

 A list of licenses currently in use 
 The name of the computer where the license currently operates 
 The login name of the user  

To access this dialog box... 
In the License Manager Dialog box, click the Floating Licenses button.  You may 
also select Floating Licenses from the File menu. 
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In this field… Do this… 

License List area Nothing. You cannot modify any license information from 
this dialog box. 

Refresh Click to update the dialog box display with the most current 
information. 

Save Saves the current license usage information into a log file. 

Close Click to close the dialog box and return to the License 
Manager dialog box.  

Help Click to access Help for this dialog box. 

 
 


